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Abstract

Model Predictive Control (MPC) is an optimal control method. At each instant of time, a per-
formance index is minimized with respect to a sequence of nominal control inputs and the first
optimal control inputs are applied to the plant. At the next time step, the optimization problem
is formulated and solved based on new estimates of states. MPC for nonlinear systems can lead
to complex optimization problems, which can be computationally demanding and prevents the
real-time execution. In this thesis, we describe various low complexity computational schemes
for Nonlinear (NL) MPC controller.
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1. Introduction

1.1. Background and Motivation

Model Predictive Control (MPC) is a control strategy that calculates control inputs by solv-
ing constrained optimal control problem over a finite time horizon. At each instant of time, a
performance index is minimized with respect to a sequence of nominal control inputs and the
first optimal control inputs are applied to the plant. A new optimization problem will later be
solved when new estimation of states becomes available, this method is also called as Receding
Horizon (See figure (1.1)).

MPC arose in industrial and chemical industry in early 1960’s, called in its early version as
Identification and Command (IDCOM) and Dynamic Matrix Control (DMC). Since then, ex-
tensive research efforts have established theories for conditions on feasibility and closed-loop
stability of MPC [3], [2]. The emerging computational power paved to apply MPC to new ap-
plications. MPC is applied in power electronics [13], aviation [1] or vehicle safety [4], [9].

MPC can be computationally demanding for control of Nonlinear (NL) systems. The opti-
mization problem complexity depends on model, constraints and computational scheme. We
consider reducing the complexity of optimization problem by using approximate plant models.

MPC uses a plant model to predict its output trajectories. Nonlinear models arise in various
dynamical systems, which give rise to NL-MPC. Nonlinear MPC problems lead to nonlinear
and non-convex optimization problems, which can be computationally demanding. Hybrid
models can be used approximate nonlinear systems, however MPC schemes based on hybrid
models are often too complex. If the plant can be approximated by a Linear Time Invariant (LTI)
model, the computational-burden of MPC can be reduced significantly. However, LTI models
are often insufficient to accurately model nonlinear systems. Linear Time Variant (LTV) models
can approximate nonlinear systems more accurately. MPC based on LTV models (LTV-MPC),
can be applied to a broader class of nonlinear systems and they have less complexity than NL-
MPC.

1.2. Thesis Contributions

We have developed a MPC Toolbox capable of handling different low complexity MPC schemes.
Nonlinear MPC Toolbox can solve MPC problems based on Nonlinear, Linear Time Invariant
and Linear Time Variant models. LTI or LTV models can be used to approximate nonlinear sys-
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Figure 1.1.: MPC is done in a Receding Horizon scheme

tems, thus reducing the computational burden. Consequently, the most suitable formulation
should be chosen based on the computational power available and the accuracy of the approx-
imate models.

1.3. Thesis Review

In the next chapter, we formulate NL-MPC. In chapter three, we present LTI-MPC scheme. In
chapter four, we show the LTV-MPC. We will then extend MPC formulation to handle delayed
systems and offset-free control. In chapter five, MPC Toolbox is tested on a rich application.
The overview of the MPC Toolbox can be found in appendix.
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2. Nonlinear MPC

Hereafter, we will use the plant structure as defined in figure (2.1). The inputs of the plant
consist of manipulated variables or control inputs, measured and unmeasured disturbances.
The plant outputs consist of tracking and constrained outputs

Figure 2.1.: Plant with the inputs and outputs [7].

We assume the plant can be described by a set of first order nonlinear differential equations

ẋ = fc(x(t), u(t), d(t), v(t)), (2.1a)

y = h(x(t), u(t), d(t), v(t)), (2.1b)

where x ∈ Rn is the state vector, u ∈ Rm is manipulated variables of the plant, d ∈ Rmd is
the measured disturbances and v ∈ Rumd is the unmeasured disturbances of the plant. We
partition the output vector y ∈ Rp as y = [yT

tr yT
c yT

sc]
T where ytr ∈ Rpy are the outputs to be

tracked, yc ∈ Rpc are the outputs to be hard constrained and ysc ∈ Rpu are the outputs to be
soft constrained.

We assume the state update function fc, and output function h are continuously differen-
tiable. The plant model (2.1) can be converted to the following discrete time model

x(t + h) = f (x(t), u(t), d(t), v(t)) = x(t) + Ts fc(x(t), u(t), d(t), v(t)), (2.2a)

y = h(x(t), u(t), d(t), v(t)). (2.2b)

For simplicity, we will assume the sample time (Ts) to be one. Since we consider the optimal
control problem to be solved using a digital processor, we hereafter will use the discrete time

3



plant description (2.2). The control input rate can be calculated as

4u[t + i|t] = u[t + i + 1|t]− u[t + i|t]. ∀i ∈ {0, ..., N}. (2.3)

We formulate Nonlinear MPC problem as follows

J∗(x(t), u(t),4u(t), ...,4u(t + Hc − 1)) = min
4u(t),...,4u(t+Hc−1)

Hp

∑
i=0

l(y(t + i|t), u(t + i|t)). (2.4)

Subject to

x(t + i + 1|t) = f (x(t + i|t), u(t + i|t), d(t + i|t)) ∀i ∈ {0, ..., Hp − 1}, (2.5a)

y(t + i|t) = h(x(t + i|t), u(t + i|t), d(t + i|t)) ∀i ∈ {0, ..., Hp − 1}, (2.5b)

x(t|t) = x(t), (2.5c)

x(t + i|t) ∈ X (t + i|t) ∀i ∈ {0, ..., Hp − 1}, (2.5d)

y(t + i|t) ∈ Y(t + i|t) ∀i ∈ {1, ..., Hp}, (2.5e)

u(t + i|t) ∈ U (t + i|t) ∀i ∈ {1, ..., Hc}, (2.5f)

4u(t + i|t) ∈ 4U (t + i|t) ∀i ∈ {0, ..., Hc − 1}, (2.5g)

The notation y(t + i|t) denotes that the output predicted at time t + i is based on the infor-
mation available at time t. The function l is the performance index function. X ,Y ,U ,4U are
the set of admissible states, outputs, control inputs and control input rates, respectively. We
assume that the control input remains unchanged after a control horizon (Hc) which is smaller
than the prediction horizon (Hp).
The optimal control sequence [4u∗(t), ...,4u∗(t + Hc − 1)] is found by minimizing (2.4) sub-
ject to (2.5). The optimization problem can be solved using a nonlinear optimization solver
[10]. The first optimal control input is then applied to the plant. At the next sampling time the
plant states are estimated and a new optimization problem is solved over a shifted horizon.
However, the optimization problem (2.4) is in general non-convex and can be computationally
demanding for real-time applications.

We use a quadratic function for the performance index, that is to use squared 2 norm to
penalize tracking error, control input and input changes. Additionally, we define the feasibility
regions with different polytopes. The following Nonlinear MPC formulation is defined in MPC
Toolbox

J∗(x(t), u(t),4u(t), ...,4u(t + Hc − 1)) = min
4u(t),...,4u(t+Hc−1)

Hp

∑
i=1
||Q[ytr(t)(t + i)− yre f (t + i)]||22+

||Su(t + i)||22 + ||R4u(t + i− 1)||22.
(2.6)
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Subject to

x(t + i + 1|t) = f (x(t + i|t), u(t + i|t), d(t + i|t), v(t + i|t)) ∀i ∈ {0, ..., Hp}, (2.7a)

y(t + i|t) = h(x(t + i|t), u(t + i|t), d(t + i|t), v(t + i|t)) ∀i ∈ {0, ..., Hp}, (2.7b)

x(t|t) = x(t) (2.7c)

u[t + i + 1|t] = u[t + i|t] +4u[t + i|t] ∀i ∈ {0, ..., Hc − 1}, (2.7d)

4Ul(t + i) ≤ 4u[t + i|t] ≤ 4Uu(t + i) ∀i ∈ {0, ..., Hc}, (2.7e)

Ul(t + i) ≤ u[t + i|t] ≤ Uu(t + i) ∀i ∈ {1, ..., Hc}, (2.7f)

Yc,l(t + i) ≤ yc[t + i|t] ≤ Yc,u(t + i) ∀i ∈ {0, ..., Hp}, (2.7g)

Ysc,l(t + i) ≤ ysc[t + i|t] ≤ Ysc,u(t + i) ∀i ∈ {0, ..., Hp}, (2.7h)

El ≤ ytr[t + i|t]− yre f [t + i|t] ≤ Eu ∀i ∈ {0, ..., Hp}, (2.7i)

Gl ≤ E[x(t)...x(t + Hgc)] + F[u(t)...u(t + Hgc)] ≤ Gu, (2.7j)

where Ul , Uu and 4Ul ,4Uu are the lower and upper bound on control inputs and control
input rates. Yc,l , Yc,u are the lower and upper bound on hard constrained outputs. Ysc,l , Ysc,u

are the lower and upper bound on soft constrained outputs. El , Eu are the lower and upper
bound on tracking error. Gl , Gu are the lower and upper bound on general constraints.

5 CHALMERS, Master’s Thesis 2011:May
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3. Linear Time Invariant MPC

NL-MPC defined in previous chapter can be computationally demanding. Optimization prob-
lem complexity, among others, can stem from model nonlinearities. In this chapter, we consider
linearizing the plant model around the operation point to obtain Linear Time Invariant (LTI)
MPC scheme.

3.1. Plant Model

The plant model (2.2) can be linearized around the operation point to yield the linearized plant
formulation

x(k + 1) = A x(k) + B u(k) + Bd d(k), (3.1a)

y(k) = C x(k) + D u(k) + Dd d(k), (3.1b)

where A ∈ Rn×n, B ∈ Rn×m, Bd ∈ Rn×md, C ∈ Rp×n, D ∈ Rp×n, Dd ∈ Rp×md. We partition the
output vector y ∈ Rp as y = [yT

tr yT
c yT

sc]
T where ytr ∈ Rpy are the tracking outputs, yc ∈ Rpc

are the hard constrained outputs and ysc ∈ Rpu are the soft constrained outputs. The matrices
A, B, Bd, C, D, Dd are calculated as

A = (
∂ f
∂x

)x=x̄,u=ū,d=d̄, B = (
∂ f
∂u

)x=x̄,u=ū,d=d̄, (3.2a)

Bd = (
∂ f
∂d

)x=x̄,u=ū,d=d̄, C = (
∂h
∂x

)x=x̄,u=ū,d=d̄, (3.2b)

D = (
∂h
∂u

)x=x̄,u=ū,d=d̄, Dd = (
∂h
∂d

)x=x̄,u=ū,d=d̄. (3.2c)

where (x = x̄, u = ū, d = d̄) denotes the operation point.
By using (2.3), the state space model (3.1) can be rewritten as

x̃(k + 1|t) = Ãx̃(k|t) + B̃4u(k|t) + d̃(k|t), (3.3a)

y(k) = C̃ x̃(k|t) + D̃4u(k|t) + ẽ(k|t), (3.3b)

7



where

Ã =

(
A B

0m×n Im

)
, B̃ =

(
B
Im

)
(3.4a)

, C̃ =
(
C D

)
, D̃ = D, (3.4b)

x̃(k|t) =
(

x(k|t)
u(k− 1|t)

)
, (3.4c)

d(k|t) =
(

Bdd(k|t)
0m

)
, (3.4d)

ek,t = Dd d(t|t) (3.4e)

(3.4f)

where 0n and In are zero and identity matrix of size n.

The predicted output at time t+ i can be written in terms of the state at time t and the control
inputs u(t), · · · , u(t + i− 1) as

y(t + i|t) = C̃Ãix(t|t) + C̃
i−1

∑
k=0
Ãi−k−1B̃4u(t + k|t)+

C̃
i−1

∑
k=0
Ãi−k−1d̃(t|t) + D̃4u(t + i|t) + ẽ(t|t).

(3.5)

The output prediction vector Y(t) containing output predictions over a time horizon of Hp

steps can be calculated as

Y(t) = Ψx(k|t) + Θ4U (t) + ΓΦ(t) + Λ(t), (3.6)

where Y(t) ∈ RpHp ,4U (t) ∈ RmHc , Φ(t) ∈ RnHp and Λ(t) ∈ RpHp . Accordingly Ψ ∈ RpHp×n ,
Γ ∈ RpHp×nHp and Θ ∈ RpHp×mHc are defined as

CHALMERS, Master’s Thesis 2011:May 8



Ψ =



C̃Ã
C̃ÃÃ

C̃
2

∏
i=0
Ã

...

C̃
Hp−1

∏
i=0
Ãi,t


, Θ =



C̃B̃ D̃ · · · 0
C̃ÃB̃ C̃B̃ D̃ · · · 0
C̃ÃÃB̃ C̃ÃB̃ C̃B̃ D̃ · · ·

...
...

...
. . .

C̃
Hc−1

∏
i=1
ÃB̃ C̃

Hc−1

∏
i=2
ÃB̃ · · · · · · C̃B̃

C̃
Hc

∏
i=1
ÃB̃ C̃

Hc

∏
i=2
ÃB̃ · · · · · · C̃ÃB̃

... · · · · · · . . .
...

C̃
Hp−1

∏
i=1
ÃB̃ C̃

Hp−1

∏
i=2
ÃB̃ · · · · · · C̃

Hp−1

∏
i=Hc

ÃB̃



Γ =



C̃ 0p×n · · · 0p×n

C̃Ã C̃ . . .
...

... · · · . . .
...

... · · · . . .
...

C̃
Hp−1

∏
i=1
Ã C̃

Hp−1

∏
i=2
Ã · · · C̃



Φ =


d̃(t|t)
d̃(t|t)

...
d̃(t|t)

 , Λ =


0

e(t|t)
...

e(t|t)



(3.7)

Note here that the matrices Ψ,Γ and Θ are time independent and they can be computed offline.
Moreover, output predictions for the tracking and constrained outputs can be divided by

Ytr(t) = Atr Y(t), (3.8a)

Yc(t) = Ac Y(t), (3.8b)

Ysc(t) = Asc Y(t), (3.8c)

where Atr, Ac and Asc are defined as

9 CHALMERS, Master’s Thesis 2011:May



Atr =

 Ipy×py 0py×pc 0py×pu

0pc×py 0pc×pc 0pc×pu

0pu×py 0pu×pc 0pu×pu


p×p

⊗ 1Hp×Hp , (3.9a)

Ac =

0py×py 0py×pc 0py×pu

0pc×py Ipc×pc 0pc×pu

0pu×py 0pu×pc 0pu×pu


p×p

⊗ 1Hp×Hp , (3.9b)

Asc =

0py×py 0py×pc 0py×pu

0pc×py 0pc×pc 0pc×pu

0pu×py 0pu×pc Ipu×pu


p×p

⊗ 1Hp×Hp (3.9c)

with ⊗ denoting Kronecker product and 1i×j is the matrix(i× j) of ones. Using the equation
(3.8), we can derive

AtrY(t)︸ ︷︷ ︸
Ytr(t)

= AtrΨ︸ ︷︷ ︸
Ψtr

x(k|t) + AtrΘ︸ ︷︷ ︸
Θtr

4U (t) + AtrΓ︸︷︷︸
Γtr

Φ(t) + AtrΛ(t)︸ ︷︷ ︸
Λtr(t)

, (3.10a)

AcY(t)︸ ︷︷ ︸
Yc(t)

= AcΨ︸︷︷︸
Ψc

x(k|t) + AcΘ︸︷︷︸
Θc

4U (t) + AcΓ︸︷︷︸
Γc

Φ(t) + AcΛ(t)︸ ︷︷ ︸
Λc(t)

, (3.10b)

AscY(t)︸ ︷︷ ︸
Ysc(t)

= AscΨ︸ ︷︷ ︸
Ψsc

x(k|t) + AscΘ︸ ︷︷ ︸
Θsc

4U (t) + AscΓ︸︷︷︸
Γsc

Φ(t) + AscΛ(t)︸ ︷︷ ︸
Λsc(t)

. (3.10c)
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3.2. Quadratic Programming Formulation

We convert the optimal control formulation defined as (2.6) with the predictions made as (3.7),
to a quadratic programming which can be solved by standard solvers. The standard quadratic
programming has the form

J∗(X ∗(t)) = min
X (t)

XT AX + BX

subjectto : Xl ≤ EX ≤ Xu

(3.11)

The performance index (2.4) can be calculated as

J = ||Q(E f + E)||22 + ||SU (t)||22 + ||R4U (t)||22 + ρε2 (3.12a)

E f = Yre f (t)−Ψtr x̃(k|t)− ΓtrΦ(t)−Λtr(t) (3.12b)

E = Θtr4U (t) (3.12c)

We call E f ∈ RpHp free response tracking error, and E ∈ RpHp is control move improvement
of the tracking error. We can transform (3.12) to the following quadratic programming

4U ∗(t) = arg min
4U (t)

J = [4U (t)T, ε]Ht[4U (t)T, ε]T +Ft[4U (t)T, ε]T (3.13a)

Ht =

(
ΘT

trQΘtr + R + AT
a SAa 0mHc×1

01×mHc ρ

)
(3.13b)

Ft = 2ET
f QΘtr (3.13c)

where Aa ∈ RHc×Hc is the lower triangular matrix defined as

Aa =


1 0 0 · · · 0
1 1 0 · · · 0
1 1 1 · · · 0
...

...
... · · · 0

1 1 1 · · · 1


Hc×Hc

⊗ Im (3.14)

The constraints (2.5) can then be converted to

4Ul ≤ 4U ≤ 4Uu, (3.15a)

Ul −Ut ≤ 4U ≤ 4Uu −Ut, (3.15b)

El ≤ Yre f (t)−Ψtr x̃(k|t)− ΓtrΦ(t)−Λtr(t)−Θtr4U (t) ≤ Eu, (3.15c)

Yc,l ≤ Ψc x̃(k|t) + ΓcΦ(t) + Λc(t) + Θc4U (t) ≤ Yc,u, (3.15d)

Ysc,l − εΞ ≤ Ψsc x̃(k|t) + ΓscΦ(t) + Λsc(t) + Θsc4U (t) ≤ Ysc,u + εΞ, (3.15e)

11 CHALMERS, Master’s Thesis 2011:May



where

Ut = u(t− 1)⊗ 1Hc, (3.16a)

Ξ = 1pu.Hc. (3.16b)

We finally can write the LTI-MPC formulation implemented in MPC Toolbox as the following
standard quadratic programming

4U ∗(t) = arg min
4U (t)

J = [4U (t)T, ε]Ht[4U (t)T, ε]T +Ft[4U (t)T, ε]T (3.17)

Subject to [
4Ul

0

]
≤
[
4U (t)

ε

]
≤
[
4Uu

εu

]
(3.18a)

A 0mHc×1

−A 0mHc×1

−A 0mHc×1

Θtr 1py.Hc×1

−Θtr 1py.Hc×1

Θc 0pc.Hc×1

−Θc 0pc.Hc×1

Θsc 1pu.Hc×1

−Θsc 1pu.Hc×1



[
4U (t)

ε

]
≤



Uu −Ut

−Ul + Ut

Yre f (t)−Ψtr x̃(k|t)− ΓtrΦ(t)−Λtr(t) + Eu

−Yre f (t) + Ψtr x̃(k|t) + ΓtrΦ(t) + Λtr(t)− El

−Ψc x̃(k|t)− ΓcΦ(t)−Λc(t) + Yc,u

Ψc x̃(k|t) + ΓcΦ(t) + Λc(t)−Yc,l

−Ψsc x̃(k|t)− ΓscΦ(t)−Λsc(t) + Ysc,u

Ψsc x̃(k|t) + ΓscΦ(t) + Λsc(t)−Ysc,l


(3.18b)

where J is defined as (3.13).
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4. Linear Time Variant Model Predictive

Control

In the previous chapters, we presented the Nonlinear MPC and LTI-MPC. Although LTI-MPC
has reduced computational complexity compared to Nonlinear MPC, LTI models are often in-
sufficient to approximate nonlinear systems over wide operation region of the state and input
space. Accuracy of predictions can be improved by using Linear Time Variant(LTV) models. In
this chapter, we present MPC scheme based on LTV models, referred to as LTV-MPC. LTV mod-
els improves the accuracy of the predictions compared to LTI models while they have reduced
computational complexity compared to Nonlinear MPC.

4.1. Plant Model

We can approximate (2.2) as follows

x(k + 1) = Ak,tx(k) + Bk,tu(k) + dk,t, (4.1a)

y(k) = Ck,tx(t + i) +Dk,tu(k) + ek,t. (4.1b)

The matricesAt+i,t,Bt+i,t, Ct+i,t,Dt+i,t are calculated as in (3.2) around the operation point (x(t+
i|t), u(t + i|t), d(t + i|t)).

Using (2.3), the state space model (4.1) can be transformed to

x(k + 1|t) = Ak,tx(k|t) + Bk,t4u(k|t) + dk,t, (4.2a)

y(k) = Ck,tx(k|t) +Dk,t4u(k|t) + ek,t. (4.2b)

The matrices are defined as in (3.4), with the additional consideration that the matrices are time
variant as well.

The output prediction vector Y(t) for a horizon of Hp steps is computed as

Y(t) = Ψtx(k|t) + Θt4U (t) + ΓtΦ(t) + Λ(t). (4.3)

where Y(t) ∈ RpHp , 4U (t) ∈ RmHc and Φ(t) ∈ RnHp and Λ(t) ∈ RpHp . Accordingly
Ψ(t) ∈ RpHp×n , Γt ∈ RpHp×nHp and Θ(t) ∈ RpHp×mHc and Λ(t) ∈ RpHp×nHp are defined as
in (4.4).

In (4.3) the control input is assumed constant after Hc steps. We observe that the matrices in
(4.3) are time variant and they should be calculated at every time step, while in the LTI case the
matrices in (3.6) can be calculated offline.
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Y(t) =


y(t + 1|t)
y(t + 2|t)

...
y(t + Hp|t)

 =



C̃t+1,tÃt,t

C̃t+2,tÃt+1,t
...

C̃t+Hp,t

t+Hp−1

∏
i=t

Ãi,t


︸ ︷︷ ︸

Ψt

×x̃(t|t)+



C̃t+1,tB̃t,t D̃t+1,t · · · 0
C̃t+2,tÃt+1,tB̃t,t C̃t+2,tB̃t+1,t D̃t+2,t · · · 0

C̃t+3,tÃt+2,tÃt+1,tB̃t,t C̃t+3,tÃt+2,tB̃t+1,t C̃t+3,tB̃t+2,t D̃t+3,t · · ·
...

...
...

. . .

C̃t+Hc,t

t+Hc−1

∏
i=t+1

Ãi,tB̃t,t C̃t+Hc,t

t+Hc−1

∏
i=t+2

Ãi,tB̃t+1,t · · · · · · C̃t+Hc,tB̃t+Hc−1,t

C̃t+Hc+1,t

t+Hc

∏
i=t+1

Ãi,tB̃t,t C̃t+Hc+1,t

t+Hc

∏
i=t+2

Ãi,tB̃t+1,t · · · · · · C̃t+Hc+1,tÃt+Hc,tB̃t+Hc−1,t

... · · · · · · . . .
...

C̃t+Hp,t

t+Hp−1

∏
i=t+1

Ãi,tB̃t,t C̃t+Hp,t

t+Hp−1

∏
i=t+2

Ãi,tB̃t+1,t · · · · · · C̃t+Hp,t

t+Hp−1

∏
i=t+Hc

Ãi,tB̃t+Hc−1,t



×


4u(t|t)
4u(t + 1|t)

...
4u(t + Hc − 1|t)


︸ ︷︷ ︸

4U (t)

+



C̃t+1,t 0p×n · · · 0p×n

C̃t+2,tÃt+1,t C̃t+2,t
. . .

...
... · · · . . .

...
... · · · . . .

...

C̃t+Hp,t

t+Hp−1

∏
i=t+1

Ãi,t C̃t+Hp,t

t+Hp−1

∏
i=t+2

Ãi,t · · · C̃t+Hp,t


︸ ︷︷ ︸

Γt

×


d̃(t|t)

d̃(t + 1|t)
...

d̃(t + Hp − 1|t)


︸ ︷︷ ︸

Φt

+


0

e(t + 1|t)
...

e(t + Hp − 1|t)


︸ ︷︷ ︸

Λt

(4.4)
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4.2. Quadratic Programming Formulation

Similar to the derivation of LTI-MPC, we can transform (2.6) the quadratic programming to the
following standard quadratic programming formulation ([4])

4U ∗(t) = arg min
4U (t)

J = [4U (t)T, ε]Ht[4U (t)T, ε]T +Ft[4U (t)T, ε]T (4.5a)

Ht =

(
ΘT

t QΘt + R + AT
a SAa 0mHc×1

01×mHc ρ

)
, (4.5b)

Ft = 2ET
f QΘt, (4.5c)

Subject to [
4Ul

0

]
≤
[
4U (t)

ε

]
≤
[
4Uu

εu

]
(4.6a)

A 0mHc×1

−A 0mHc×1

−A 0mHc×1

Θtr,t 1py.Hc×1

−Θtr,t 1py.Hc×1

Θc,t 0pc.Hc×1

−Θc,t 0pc.Hc×1

Θsc,t 1pu.Hc×1

−Θsc,t 1pu.Hc×1



[
4U (t)

ε

]
≤



Uu −Ut

−Ul + Ut

Yre f (t)−Ψtr,t x̃(k|t)− Γtr,tΦ(t)−Λtr,t(t) + Eu

−Yre f (t) + Ψtr x̃(k|t) + Γtr,tΦ(t) + Λtr,t(t)− El

−Ψc,t x̃(k|t)− Γc,tΦ(t)−Λc,t(t) + Yc,u

Ψc,t x̃(k|t) + Γc,tΦ(t) + Λc,t(t)−Yc,l

−Ψsc,t x̃(k|t)− Γsc,tΦ(t)−Λsc,t(t) + Ysc,u

Ψsc,t x̃(k|t) + Γsc,tΦ(t) + Λsc,t(t)−Ysc,l


(4.6b)
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5. MPC Additional Considerations

5.1. Delayed systems formulation

The inherent optimization process for solving MPC problems leads to a computational delay.
If computational delay is not accounted, controlling the plant with MPC leads to loss of perfor-
mance or closed-loop instability [12]. The delayed MPC scheme can also be applied to delayed
plants.

Consider the optimization problem (2.6), at each time instant the optimal control input is
generated as

u(τ) = u∗(ti, x(ti)), τ ∈ [ti, ti + 1]. (5.1)

Considering the average delay of δ̄, the open-loop optimal control input applied to the plant
is

u(τ) = u∗(τ, x(ti)), τ ∈ [ti + δ̄, ti + 1 + δ̄]. (5.2)

Note that the control input at time [ti, ti + δ̄) is not determined by the optimization problem
solved for current time instant. Consequently, the following constraint should be added to
optimization formulation ([12])

ū(τ) = u∗ti−1(τ, x(ti)), τ ∈ [ti, ti + δ̄). (5.3)

When all the control input channels have equal time delay the optimization problem formu-
lation, the constraint (5.3) corresponds to letting the system run freely prior to time t + δ̄ with
the control inputs already fed to the plant, and the change of problem formulation corresponds
to updating the states. The approach is applicable for Nonlinear MPC formulation where sta-
bility can be proven for the modified MPC formulation. Assuming there is no model mismatch,
the previous optimal control inputs are feasible for the system [12].

5.1.1. Numerical Example

Consider a delayed double integrator system defined as

ẍ(t) = u(t− Td), (5.4a)

y(t) = x(t). (5.4b)

We now simulate the discrete time version of the system (5.4) using a sample time of 10 ms
and delay of 25 samples. The closed-loop system controlled with MPC results in performance
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loss and permanent oscillations (See Figure (5.1)). Using delayed MPC scheme, we achieve
stable closed-loop behavior (See Figure (5.2)).

Figure 5.1.: Delayed Double Integrator without delayed MPC scheme

Figure 5.2.: Delayed Double Integrator with delayed MPC scheme
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5.2. MPC Scaling

Let us define the following transformation

x̃ = Txx ⇔ x = T−1
x x̃, (5.5a)

ũ = Tuu⇔ u = T−1
u ũ, (5.5b)

ỹ = Txy⇔ y = T−1
y ỹ. (5.5c)

(5.5d)

The system (4.2) can then be transformed in the following way

T−1
x x̃(k + 1|k) = Ak,tT−1

x x̃(k) + Bk,tT−1
u ũ(k) + dk,t, (5.6a)

T−1
y ỹ(k) = Ck,tT−1

x x̃(k) +Dk,tT−1
u ũ(k) + ek,t. (5.6b)

Which can be written as

x̃(k + 1|k) = TxAk,tT−1
x x̃(k) + TxBk,tT−1

u ũ(k) + Txdk,t, (5.7a)

ỹ(k) = TyCk,tT−1
x x̃(k) + TyDk,tT−1

u ũ(k) + Tyek,t. (5.7b)

The state space (4.2) can then be written as

x(k + 1|k) = Ãk,tx(k) + B̃k,tu(k) + d̃k,t, (5.8a)

y(k) = C̃k,tx(k) + D̃k,tu(k) + ẽk,t, (5.8b)

Ãk,t = TxAk,tT−1
x , (5.8c)

B̃k,t = TxBk,tT−1
u , (5.8d)

C̃k,t = TyCk,tT−1
x , (5.8e)

D̃k,t = TyDk,tT−1
u . (5.8f)
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5.3. Open Loop Prediction

At each instant of time, the optimization problem (2.4) yields open loop input trajectory. Re-
spectively, open loop output trajectory can be calculated for the open loop optimal control
inputs using (2.1). Open loop predicted trajectories are useful tools to verify MPC strategies.

Figure 5.3.: Open Loop Prediction using MPC Toolbox

CHALMERS, Master’s Thesis 2011:May 20



5.4. Offset Free MPC

Non-zero steady state tracking error occurs if MPC is used to control a plant in the presence of
model mismatch. Model mismatch, among others, can happen when approximating nonlinear
plants with linear time variant models, it can also arise from unmodeled disturbance dynam-
ics. We will show that by modifying the MPC formulation, we can guarantee zero steady state
offset ([14], [5]).

As a motivating example, let us consider a stirred-tank reactor ( [8]). The plant can be de-
scribed by the following state space representation

dc
dt

=
F0(c0 − c)

πr2h
− k0cexp(− E

RT
), (5.9a)

dT
dt

=
F0(T0 − T)

πr2h
+
−4H
ρCp

k0cexp(− E
RT

) +
2Uh
rρCp

(Tc − T), (5.9b)

dh
dt

=
F0 − F

πr2 . (5.9c)

The output states represents molar concentration of the tank c, tank temperature T and level
of the tank h. The manipulated variables are coolant temperature Tc the tank outlet flow F. We
consider the inlet flow F0 as an unmeasured disturbance acting on the plant.

Figure 5.4.: Stirred Tank reactor [5]

Assuming a sampling time of one minute, the plant is linearized around the operation point
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to yield the following LTI model

x(k + 1) = Ax(k) + Bu(k) + Bp p, (5.10a)

y(k) = Cx(k). (5.10b)

(5.10c)

where the state space is given as

A =

0.2511 −3.36810−3 −7.05610−4

11.06 0.3296 −2.545
0 0 1

 , (5.11a)

B =

−5.42610−3 1.53010−5

1.297 0.1218
0 −6.59210−2

 , (5.11b)

Bp =

−1.76210−5

7.78410−2

6.59210−2

 , (5.11c)

C =

1 0 0
0 1 0
0 0 1

 . (5.11d)

(5.11e)

We assume that the inlet flow rate (p) is not measured. Assume that a constant inlet flow en-
ters the tank from time t = 10. The objective of control is to regulate the system to zero steady
state. We simulate the system (5.10) while it is controlled with MPC. We can see that the output
states has nonzero steady state offset.

Figure 5.5.: Stirred Tank reactor, unmeasured disturbance causes non-zero offset [5].
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Using Open-Loop prediction tool, we find that the plant is not changing as predicted by MPC
because of model mismatch.

Figure 5.6.: Stirred Tank reactor, Open-Loop Prediction does not conform to plant

We assume that tracking outputs ytr is a subset of measured outputs by defining

ytr = Hy(t). (5.12a)

Since, we are interested in steady states without loss of generality, we use the LTI model
(3.1). The plant is assumed to be observable and controllable. We augment the plant model
with additional states equal to the number of measured outputs

x(t + 1) = A x(t) + B u(t) + Bud ud(t), (5.13a)

ud(t + 1) = ud(t), (5.13b)

y(t) = C x(t) + Cud ud(t). (5.13c)

The Hautus observability condition for the system (5.13) to be observable, requires the matrix[
A− I Bud

C Cud

]
, (5.14)

to have full rank. This assumption in addition to the stability of the observer requires us to
have maximum number of p unmeasured disturbance states (5.15). We restrict our attention to
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the case where the number of augmented states is equal to the number of measured outputs.
Assume our system (5.13) satisfies[

A− I B
HC 0

] [
x̂∞

u∞

]
=

[
−Bud ˆud∞

yre f ,∞ − HCud ˆud∞

]
, (5.15)

where u∞ and yre f ,∞ are steady state inputs and references, respectively. It can be shown that
the observer based on the system (5.15) satisfies offset-free control [14]. Now we define the
change of variables

ũ(t) = u∞(t) + u(t), (5.16a)

ỹre f (t) = x∞(t). (5.16b)

For the transformed reference and control input, we modify the MPC formulation (A.2) to

U ∗(t) = argmin
U (t)

J =
t f

∑
i=t

[ytr − ỹre f ]
′Q[ytr − ỹre f ] + [ũ(t + i)]′S [ũ(t + i)] + [4u(t + i)]′R[4u(t + i)]

(5.17a)

Subjectto : (5.17b)

x(t + i|t) = A x(t + i− 1|t) + B u(t + i− 1|t) + Bd d(t + i− 1|t) (5.17c)

y(t + i|t) = C x(t + i|t) + D u(t + i|t) + Dd d(t + i|t) (5.17d)

x(t + i|t) ∈ X (t + i|t) (5.17e)

ũ(t + i|t) ∈ Ũ (t + i|t) (5.17f)

y(t + i|t) ∈ Y(t + i|t) (5.17g)

Assuming MPC to be unconstrained at steady state, the formulation (5.17) guarantees offset-
free control of tracking variables.

Using the offset-free MPC scheme, we will have the offset free outputs for the system (5.9)
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Figure 5.7.: Stirred Tank reactor tank level, offset-free MPC scheme [5]
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6. Results and Conclusion

In this chapter, we apply MPC Toolbox on a rich application taken from [9]. The plant to be
controlled is a vehicle. A predefined steering maneuver is to be tracked while delivering the
requested break forces to the wheels. MPC enables us to maximize the regenerative breaking
while preserving the vehicle stability.

We use the plant model as the nonlinear vehicle model taken from [4], it can be written as

mÿ = −mẋψ̇ + ∑
∗∈{ f ,r}

∑
•∈{l,r}

Fy∗,•, (6.1a)

mẍ = mẏψ̇ + ∑
∗∈{ f ,r}

∑
•∈{l,r}

Fx∗,•, (6.1b)

Iψ̈ = a ∑
•∈{l,r}

Fy f ,• − b ∑
•∈{l,r}

Fyr,• + c( ∑
∗∈{ f ,r}

Fx∗,r − ∑
∗∈{ f ,r}

Fx∗,l), (6.1c)

where ∗ ∈ { f , r} denotes the front and rear axles, • ∈ {l, r} denotes left and right side of vehi-
cle, ẏ is lateral velocity, ẋ is longitudinal velocity, ψ̇ is yaw rate, m is mass of the car, I is inertial
moment along the vertical axis, a and b are the distance of center of gravity from front and rear
axles, respectively. c is distance of the left and right wheels from longitudinal axis.

Figure 6.1.: Simplified vehicle dynamical model ([9])

The objective of the control is tracking the specified maneuver, while delivering the total re-
quested breaking forces (Frqst). The outputs of the controller are the breaking forces on each
wheel. The constraints are defined as follows, the commanded break forces are constrained to
add to the requested force. Yaw rate tracking error and lateral jerk should be bounded. More-
over, we add a constraint that 70 percent of break forces should act on the front wheels.
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The constraints can be written as

Control InputLowerBound = Ul = [0 0 0 0 0] (6.2a)

Control InputUpperBound = Uu = [2000 2000 1000 1000 2000] (6.2b)

Control InputRateLowerBound = 4Ul = [−2e5 − 2e5 − 1e5 − 1e5 − 2e5] (6.2c)

Control InputRateUpperBound = 4Ul = [2e5 2e5 1e5 1e5 2e5] (6.2d)

[
Frqst.11×Hc

01×Hc

]
≤ [kron(eye(3), [11111]); kron(eye(3), [11− 2.3− 2.30])]


u(t + 1|t)
u(t + 2|t)
u(t + 1|t)

...
u(t + Hgc|t)

 ≤
[

Frqst.11×Hc

01×Hc

]

(6.2e)

where kron(.) is Kronecker product, and eye(x) represents identity matrix of size x.

The weighting parameters are defined as

TrackingErrorWeight = Q = 1 (6.3a)

Control InputRateWeight = R = [10000 10000 10000 10000 1e− 5] (6.3b)

Control InputWeight = S = [5000 5000 4000 4000 − 1] (6.3c)

The scaling parameters are

Tu = [1/1200 1/1200 1/1200 1/1200 1/1200] (6.4a)

Ty = [1 1/4] (6.4b)

Tx = [1/2 1/20 1/0.14] (6.4c)

S = [5000 5000 4000 4000 − 1] (6.4d)

The MPC will yield the following break forces, see figure (6.2)). The resulting yaw rate given
in figures ((6.3) and (6.4)) shows consistency with previous controllers([9]) on the same problem
formulation.
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Figure 6.2.: MPC yields the commanded forces

Figure 6.3.: Output yaw rate and Reference
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Figure 6.4.: Output yaw rate and limits
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6.1. Conclusion

The results in the previous section shows consistency of MPC Toolbox with previous MPC
controllers [9]. MPC Toolbox is also compared with the MATLAB’s official version of MPC
Toolbox [7] on a double integrator, (See appendix), which verifies that we have similar results.
We thereby can assert that our Toolbox gives consistent results under different MPC schemes.
We hope that the MPC Toolbox is soon released and tested with more users. This can help us
to find possible needs or resolutions for future versions of the Toolbox.
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A. MPC Toolbox

In This chapter, we provide an overview of the MPC Toolbox. We describe how to setup the
model, specify the horizons, weights, constraints, scaling and estimator.

For a continuous time system described by the following state space formulation

ẋ = f (x(t), u(t))

y = h(x(t), u(t))
(A.1)

The output vector y is partitioned into [ytr, yc, ysc]T, Where ytr is the tracking output, yc is the
hard constrained output and ysc is the soft constrained output.

The task is to control the system to follow special trajectory, and conforms to some constraints
on outputs or control inputs, the MPC formulation can be written as

J∗(x(t), u∗(t), ..., u∗(t + Hc)) = min
4u(t),...,4u(t+Hc)

Hp−1

∑
i=0
||Q[ytr(t + i|t)− yre f (t + i|t)]||22 + ||Su(t + i|t)||22 + ||R4u(t + i|t)||22

(A.2)

Subject to

x(t|t) = x(t) (A.3a)

u[t + i + 1|t] = u[t + i|t] +4u[t + i|t] ∀i ∈ {0, ..., Hc − 1} (A.3b)

4Ul(t + i) ≤ 4u[t + i|t] ≤ 4Uu(t + i) ∀i ∈ {0, ..., Hc − 1} (A.3c)

Ul(t + i) ≤ u[t + i|t] ≤ Uu(t + i) ∀i ∈ {1, ..., Hc} (A.3d)

Yc,l(t + i) ≤ yc[t + i|t] ≤ Yc,u(t + i) ∀i ∈ {1, ..., Hp} (A.3e)

Ysc,l(t + i) ≤ ysc[t + i|t] ≤ Ysc,u(t + i) ∀i ∈ {1, ..., Hp} (A.3f)

El ≤ ytr[t + i|t]− yre f [t + i|t] ≤ Eu ∀i ∈ {1, ..., Hp} (A.3g)

Gl ≤ E[x(t)...x(t + Hgc)] + F[u(t)...u(t + Hgc)] ≤ Gu (A.3h)

In the following sections, we will describe how this formulation can be embedded in the
MPC Toolbox.
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A.1. Software Installation

MPC toolbox requires MATLAB and a compatible C compiler. It is required that MATLAB in-
cludes Simulink and Real Time Workshop. The toolbox is tested with Visual Studio 2005, and
MATLAB R2008a up to R2010a.

Download and extract the compressed archive MPC Toolbox v1.zip, then use MATLAB ad-
dpath command to add the toolbox and its subfolder to MATLAB’s default search path,i.e. run

>> addpath(genpath(′MPCToolbox v1′))
>> savepath

Alternatively, you can use File > Set Path to open the Set Path dialog box, and add the tool-
box and its subfolders to MATLAB’s search path and save it. Make sure the compiler is set
correctly in MATLAB using

>> mex− setup

You can now start with one of the examples of the graphical user interface using

>> mpcdesign

When running the toolbox for the first time you will need to provide the directory where tool-
box is located,e.g. where the file MPC.C is located in. It is recommended to explore the GUI
and examples before starting your own project.
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A.2. MPC Model

We here present a double integrator example for illustration on how to use the correct syntax.
For the Nonlinear MPC formulation given as

ẋ = f (x(t), u(t))

y = h(x(t), u(t))
(A.4)

The model could be written in the form of Nonlinear MPC model formulation as
no of states = 2;
no of inputs = 1;
no of disturbance = 1;
no of outputs = 2;
no hard constrained outputs = 0; %optional
no soft constrained outputs = 0; %optional
sample time = 0.01; %optional
time delay = [0];
no of params = 1;
%%StateSpaceModel
dx1 = x2;
dx2 = u1;
out1 = x1;
out2 = x2;
%%LinearizedStateSpaceModel

The reserved words for the formulation are ‘xN ,uN ,dN ,pN ,dxN ,outN’, which corresponds to
states, control input, measured disturbance, parameters, derivative function( f ), output func-
tion h.
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The model also could be described by Linear Time Invariant system as

x(t + 1) = A x(t) + B u(t) + Bd d(t)

y(t) = C x(t) + D u(t) + Dd d(t)
(A.5)

which can be fully described for MPC design tool by the appropriate definition of matrices

A =

[
0 1
0 0

]
, B =

[
0
1

]
, Bd =

[
0
0

]
,

C =

[
1 0
0 1

]
, D =

[
0 0
0 0

]
, Dd =

[
0
0

]
.

(A.6)
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The Linear Time Variant form described as

x(t + i + 1) = At+i,tx(t + i) + Bt+i,tu(t + i) + dt+i,t

y(t + i) = Ct+i,tx(t + i) +Dt+i,tu(t + i) + et+i,t
(A.7)

the corresponding model compatible for MPC Toolbox is defined as
no of states = 2;
no of inputs = 1;
no of disturbance = 1;
no of outputs = 2;
no hard constrained outputs = 0; %optional
no soft constrained outputs = 0; %optional
sample time = 0.01; %optional
time delay = [0];
no of params = 1;
%%StateSpaceModel
dx1 = 0;
dx2 = 0;
out1 = x1;
out2 = x2;
%%LinearizedStateSpaceModel sp A1 = 0;
sp A2 = 1;
sp A3 = 0;
sp A4 = 0;
sp B1 = 0;
sp B2 = 1;
sp F1 = 0;
sp F2 = 0;
sp C1 = 1;
sp C2 = 0;
sp C3 = 0;
sp C4 = 1;
sp D1 = 0;
sp D2 = 1;
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To specify the corresponding model for MPC Toolbox, you should specify the MPC formu-
lation and appropriate model. Using design tool you can choose MPC formulation (See figure
(A.1)) and choose the model (See figure (A.2)).

Figure A.1.: MPC formulation can be specified in design tool
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Note: For a nonlinear model you can specify

• LinearTimeVariant−NumericalLinearization

• Nonlinear

where for Linear Time Invariant model you can specify

• LinearTimeInvariant

• LinearTimeInvariant−AnalyticalFormulation

and for Linear Time Variant model you can specify

• LinearTimeVariant−AnalyticalFormulation

The distinction between the analytical LTI and LTV formulation is due to the assumption
that LTV formulation is linearized around a nonlinear trajectory.

Figure A.2.: Using design tool you can specify you model
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A.3. MPC Objective

We then specify the MPC objective defined as

U ∗(t) = argmin
U (t)

J =
t+Hp

∑
i=t

[ytr − yre f ]
′Q[ytr − yre f ] + [U (t)]′S [U (t)] + [4U (t)]′R[4U (t)] (A.8)

MPC objective is specified by indication of MPC horizons and weights. Using design tool you
can specify the horizons in MPCSetup tab. You then should specify the prediction horizon,
control horizon and constraint horizon.

Figure A.3.: You can specify the MPC horizons in design tool
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The next step to define the MPC objective is to define the MPC weights. You can specify
the MPC weights inside the design tool under MPC weights tab.Moreover, you can specify the
weight penalty on control inputs, command changes(A.4), tracking error, and slack variable,i.e.
feasibility violation for soft constrained variables.

Figure A.4.: Input Penalties
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A.4. MPC constraints

Next we define the MPC constraints given in the form

4Ul ≤ U ≤ 4Uu f or 4U (t) · · · U (t + Hu) (A.9a)

Ul ≤ U ≤ Uu f or U (t) · · · U (t + Hu) (A.9b)

Yc,l ≤ yc ≤ Yc,u f or t ∈ [t, t + Hc] (A.9c)

Ysc,l ≤ ysc ≤ Ysc,u f or t ∈ [t, t + Hc] (A.9d)

El ≤ |ytr − yre f | ≤ Eu f or t ∈ [t, t + Hc] (A.9e)

(A.9f)

Under constraints tab, you can specify control input upper and lower bound and bounds on
the command changes(A.5). You can also specify the constraints on output tracking,hard con-
strained, and soft constrained variables. Note the constraints on tracking variable is assumed
on tracking error.

Figure A.5.: Input Constraints
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General constraints has the form

GL− Ds ≤ E


x(t + 1|t)
x(t + 2|t)
x(t + 1|t)

...
x(t + Hgc|t)

 + F


u(t + 1|t)
u(t + 2|t)
u(t + 1|t)

...
u(t + Hgc|t)

 ≤ GU + Ds (A.10)

Figure A.6.: General Constraints
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A.5. Real-Time Implementation

MPC Simulink Block can be used for Real-Time Hardware. The MPC Toolbox is tested success-
fully for dSPACE - MicroAutoBox-1401 Power Processors and for MATLAB - xPC target. We
here include the necessary steps you should take when using MPC Simulink Block for Real-
Time Hardware.

First, Make sure the correct Building Target is selected for Simulink. Using Simulation→
Configuration Parameters→ Real Time Workshop→ System Target file. The corresponding
target for xPC target is ’xpctarget.tlc’. The corresponding target for MicroAutobox Power PC is
’rti1401.tlc’.

Figure A.7.: To setup the Real-Time Workshop you should choose the target correctly
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Second, Make sure the MPC libraries are included inside MATLAB Simulink window: Simulation→
Configuration Parameters→Real Time Workshop→ Custom Code→ Libraries

Figure A.8.: The MPC libraries should be added to build the system into the corresponding
Real-Time target
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Additionally, It might be necessary to use the MPC Toolbox exactly inside where your Simulink
block is located.

To build for xPC Target on MATLAB version higher than 2008a the following code should be
changed inside the file:
′(MATLAB ROOT) \ toolbox \ rtw \ targets \ xpc \ xpc \ xpc \ xpc vc.tm f ′

LDFLAGS =′ ...′

Should be changed to
LDFLAGS = .../NODEFAULTLIB : MSVCRT.lib/NODEFAULTLIB : LIBC.lib/NODEFAULTLIB :

LIBCD.lib
Having done the previously mentioned steps, you can use the MPC Simulink block inside

your model and download it using Simulink Build feature to your desired target. The tests
taken so far, have shown consistency with the MPC Simulations.
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A.6. Advanced Features

You can specify the state, output, input scaling defined as

x̃ = Txx (A.11a)

ũ = Tuu (A.11b)

ỹ = Tyy (A.11c)

(A.11d)

Using the design tool, you can specify under the scaling tab as follows

Figure A.9.: Input Scaling

Finally, the estimator can be determined inside design tool
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Figure A.10.: Output Scaling

Figure A.11.: Estimator setup
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A.7. Simulink Block

The MPC can be simulated using MPC simulink block. The simulink blocks can be found by
entering
>> MPC model

Note that the compilation should be done to be able to use the MPC simulink block.

The reference generator creates the reference corresponding to the reference model. When
no reference model is specified, it is assumed the reference is not changing over prediction
horizon.

Figure A.12.: Simulink Block

You should specify the MPC Simulink Block’s input parameters. In main block, you should
give the MPC structure variable’s name. MPC structure should be available in the workspace.
Moreover, you should specify which input ports for MPC Simulink block is used. Default
parameters are assumed for the unused ports.
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Figure A.13.: Simulink MPC main, you should give the MPC structure variable name

Figure A.14.: Simulink MPC input port, you should define which inputs are given to the MPC
simulink’s block
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Figure A.15.: Simulink MPC Post Processing ports, you should define which inputs are given
to the MPC simulink’s block
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A.8. MPC commands

MPC Toolbox can be used inside your own MATLAB functions. In this section, we describes
the commands to embed MPC Toolbox in your functions.

A.8.1. General Formulation

To setup MPC you should specify a model for the plant, define constraints and weights on
tracking error, control input and command changes. Reference model can also be included
which enables MPC to anticipate the reference changes (look-ahead feature).

Horizons

You can define the following variables to specify the MPC horizons.
MPC.Hp, Hp should contain the prediction horizon, where the outputs are estimated for Hp
steps ahead, and the optimality and feasibility of the problem will be ensured for the Hp steps
ahead.
MPC.Hu, Hu should contain the control horizon. The optimal control inputs are obtained
by considering the optimality for Hu steps command changes. It is assumed the prediction is
bigger than control horizon, where the control inputs remain unchanged after Hu steps.
MPC.Hc, Hc should contain the constraint horizon. Where the constrained outputs and soft
constrained inputs are ensured to remain feasible in Hc steps.

Defining Constraints

For handling the constrained MPC, you need to specify the bound on input and output vari-
ables. The constraints can be of type hard and soft. The soft constraint is assumed to have a
tolerance on feasibility violations, in contrast hard constrained variables can not get violated.
The violation of the soft constraints will be penalized to ensure least violation of constraints.

MPC.constraints.u ubnd, u ubnd should contain the upper bounds on the control inputs.
MPC.constraints.u lbnd, u lbnd should contain the lower bounds on the control inputs.
MPC.constraints.u sc upper, u sc upper should contain the upper bounds on the control in-
puts.
MPC.constraints.u sc lbnd, u sc lbnd should contain the lower bounds on the control inputs.
MPC.constraints.du ubnd, du ubnd should contain the upper bounds on the control input
changes.
MPC.constraints.du lbnd, du lbnd should contain the lower bounds on the control input changes.
MPC.constraints.y c ubnd, y c ubnd should contain the upper bounds on the hard constrained
outputs.
MPC.constraints.y c lbnd, y c lbnd should contain the lower bounds on the hard constrained
outputs.
MPC.constraints.y sc ubnd, y sc ubnd should contain the upper bounds on the soft constrained
outputs.
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MPC.constraints.y sc lbnd, y sc lower should contain the lower bounds on the soft constrained
outputs.
MPC.constraints.e sc ubnd, e sc ubnd should contain the upper bounds on the tracking errors.
MPC.constraints.e sc lbnd, e sc lbnd should contain the lower bounds on the tracking errors.

Defining Weights

In the current version of the toolbox, enabling the user to have time varying weighting. Weight-
ing penalties can be matrices of the appropriate dimension.

Q, Weight on the tracking errors, where the dimension should agree with the number of
tracking outputs. R, Weight on the input rates, where the dimension should agree with the
number of control inputs. S, Weight on the inputs, where the dimension should agree with the
number of control inputs.
rho, Weight on the slack variable which is the maxiumum amount where the constraints are
violated.

Additional parameters

You can define the following parameters to specify the MPC controller solver.
MPC.solver, By determining this parameter you can choose from the solvers LSSOL ([11]),QPDANTZ,
NPSOL ([10]), qpOASES ([6]) .

MPC.bu f f er variables, This parameter forces the MPC to compute all the matrices once, which
improves the controllers speed for time invariant plants.

Saving the structure

>> MPC = savempcparams(MPC, model file, ref file);
The command savempcparams generates the model and generates the MPC structure for the
MPC Simulink Block. The inputs of the subroutine are MPC structure including the MPC op-
tions, model and reference files.

Compilation

>> compilempc(compile type);
The command compilempc generates the MATLAB executable files to be used inside the Simulink.
compile type could take the following types
all (Default) Where the MPC and reference, MATLAB executable files are generated.
all+ (Default) Where the MPC,reference and plant, MATLAB executable files are generated.
The plant will start initially with the initial state specified.
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MPC (Default) Where the MPC, MATLAB executable files are generated.
re f (Default) Where the reference, MATLAB executable files are generated.

For the double integrator example using the following code one can run the toolbox
model file =′ funcs2Ic.m′;
ref file =′′;
MPC.u ubnd = [5];
MPC.u lbnd = [−5];
MPC.du ubnd = [1];
MPC.du lbnd = [−1];
MPC.du ubnd = [1];
MPC.Hu = 40;
MPC.Hp = 50;
MPC = savempcparams(MPC, model file, ref file);
compilempc(′all+′);

A.9. Example

We define our state space formulation by

A =

[
0 1
0 0

]
, B =

[
0
1

]
, Bd =

[
0
0

]
,

C =

[
1 0
0 1

]
, D =

[
0 0
0 0

]
, Dd =

[
0
0

]
.

(A.12)

We introduce how this simple state space model can be embedded in Model Predictive Con-
trol Toolbox. We do it in the following steps. First, we define the Model Predictive Control
formulation using design tool as Linear Time Invariant formulation, and determine the state
space model, We then define tuning parameters. We define any positive definite matrix for
tracking error weight, input weight and output weight. Finally, we can use MPC Simulink
block to simulate the system(Figure (A.16)) , which yields the optimal output trajectory shown
in Figure(A.17)
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Figure A.16.: The MPC Toolbox can be embedded in Simulink software

Figure A.17.: The resulting optimal trajectory
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